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Typographical Conventions 

FB12 Luminometer 

Messages on the LC display are printed in boldface type,  
e.g. menu MEASURE, SCROLL or MAIN.  
The <ENTER> function key is printed in boldface inside pointed 
brackets. 

PC software 

Menu and option titles of the PC software are printed in boldface 
inside square brackets ([ ]), 
e.g., [File], [Options]. 

PC software buttons are printed in boldface inside pointed 
brackets (<>),   
e.g., <OK>, <Start Quick Measurement>, <F1>, <enter>, <Alt>. 
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Safety Instructions 

The FB12 luminometer was manufactured in accordance with 
safety requirements for electronic and medical luminometers. It is 
the operator's responsibility to adhere to regulations on the 
installation and/or operation of sample measuring systems that 
are required by law. 

The manufacturer guarantees safe operation of the equipment, 
both electrically and mechanically, if user follows the instructions 
set forth in this manual. The user must ensure that the 
instruments are set up and installed in such a way that their 
function is not impaired. 

The instruments have been tested by the manufacturer and are 
supplied in a condition that allows safe and reliable operation. 

This User’s Manual includes information and warnings that have 
to be observed by the user to ensure safe operation of the 
instruments. 

Please adhere to the following safety instructions before 
taking the instrument into service and during operation of 
the system: 

1. Only trained personnel may operate the instrument. It is 
strongly recommended that all users read this manual prior to 
use. 

2. The instrument may only be used for the designated 
application. A single sample luminometer is employed for 
detection of chemi- and bioluminescence in different sample 
tube formats. 

3. Berthold Detection Systems assumes no liability for any 
damages, including those to third parties, caused by improper 
use or handling of the device. 

4. The system is designed according to the IEC 1010-1 or 
EN 610 10-1 regulations for electrical measuring systems. 

5. Only qualified personnel may carry out Service and repair 
work . Reassemble it completely before use. 

6. The user may only perform the maintenance work described 
in this manual. 

!



 
 Safety Instructions FB12 Luminometer 
 
 

 

 

2 

7. Use only parts described in this manual for servicing. 

8. The instruments are live and improper handling may cause 
damage. 

9. If you realize that the instrument has become unsafe to use, 
switch it off and disconnect it from the power supply. 

10. All instruments supplied and all additional devices must be 
grounded. Use three-prong, grounded plugs. 

11. Before opening the locking screw or the instrument head on 
the top side of the instrument, disconnect power and then 
open the sample drawer to protect the photomultiplier against 
direct incident light. Otherwise, the photomultiplier may get 
damaged!  
Do not keep the sample drawer open for a long period of 
time. 

12. If liquid gets inside the instrument, pull the power cord. Clean 
the unit or have it cleaned by an authorized service center . 

The tests and maintenance work recommended by the 
manufacturer should be performed to make sure that the operator 
remains safe and that the instrument continues to function 
correctly. Authorized service engineers must perform any service 
and maintenance work not described in the operating manual. 

Return shipment If the instrument has to be returned to Berthold Detection 
Systems for servicing or inspection, we recommend that you use 
the original cardboard box.  

Please remove the reflector (sample holder) in order to avoid 
damage to the sample chamber (see chapter 14).  

!  

!  
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sample luminometer, designed specifically for the detection of 
chemiluminescence and bioluminescence in different kinds of 
applications. It can be employed for all glow type measurements. 
The sample chamber accommodates various sample formats. 
FB12 may be operated as a standalone instrument using special 
Windows software.. 

Optionally, an external printer can be connected to the FB12. In 
this case, additional cut-off measurements can be run on the 
standalone instrument and the results can be output to printer 
(see chapter 11). 

Luminometer installation  

� The instrument should be set up in a dry, dust-free 
environment and protected from direct sunlight and significant 
temperature fluctuations! 

� Carefully unpack the FB12 Luminometer and put it on your 
desktop. 

� Plug the connector module that fits into your wall outlet onto 
the power supply unit.  

� Plug the power supply unit into a wall outlet and the pin 
connector of the power supply unit into the socket on the 
instrument rear panel. 

� Turn the instrument on at the mains switch. The display will 
show: „Please wait“ while the instrument is performing a self-
test. Then the main menu appears. 

� Open the sample drawer and insert the sample holder 
(reflector).  

� Different sample formats may be used: 
Culture dishes with up to 35 mm diameter 
Scintillation bottles containing up to 20 ml  
Reaction bottles with up to 12 mm diameter and up to 75 mm 
length (see chapter 13).  
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Configuration 

Set up the instrument parameters according to your needs as 
follows (confirm entries with <Enter>, push <Next> to continue 
with next display): 

FB12 LUMINOMETER  

MEASURE MEAS.SET. NEXT 
               Ð 

 

PC-OPER SYSTEM MAIN 
                                                                                  Ð 

SYSTEM  

CONFIG CHECK NEXT 
 Ð 

USE RS232 FOR  PC/PRINTER: 

SCROLL    MAIN NEXT 

� Select PC if the FB12 is used as standalone instrument for 
raw data measurements or if the luminometer is connected to 
a PC.  

� If you are using the FB12 as standalone instrument to run cut-
off measurements or you want to print out raw data, then 
connect an external printer and select PRINTER (see chapter 
11).  

� Then select the desired language and enter Date and Time, 
Baudrate (9600) and the RLU factor = 1. 

ON/OFF 
switch 
 
 
 
 
Serial 
port  
 
Socket 

Figure 1: 
FB12 

Luminomete
r (rear view)  
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2. Structure of Microprocessor Software 

Operating elements on the front panel 
 

FB12 LUMINOMETER V3.0
MEASURE MEAS.SET. NEXT

ENTER

 

Main menu  Softkey  Function key <enter> 

 

Meaning and operation of individual functions  

MEASURE Measurement in stand-alone mode after input of measurement  
parameters and configuration.  

MEAS.SET. Define the measurement parameters for stand-alone operation.  

If the interface is set to PRINTER, you may choose parameter 
entry either for a raw data or for a cut-off measurement (see 
chapter 11). 

PC-OPER Switchover to PC-OPERATION. This function is not available if 
the interface has been set to PRINTER. 

SYSTEM CONFIG:  Define the system parameters.  
 CHECK:  Here a continuous measurement is performed (see 

chapter 3.3). 

Accept Confirm each entry or new setting with <ENTER>. If you want to 
keep a setting, you may proceed directly with NEXT or MAIN. 

Input CURSOR Move the cursor left.  
SCROLL The highlighted digit or letter is incremented by 1  

(cyclical order: 0, 1... 9, 0, 1... and A, B ...Z, A ...). 
 

Figure 2: 
Operating elements 
on front panel  

FB12 Luminometer
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3. Measurement in Stand-alone Mode 

3.1 Overview 

The luminometer should be switched on at least 30 minutes 
before starting a measurement. 

Units 

Luminescence is measured in „Relative Light Units“ (RLU). The 
RLU/s displayed by the FB12 luminometer are equal to the 
counts/s picked up by the detector, with the default RLU factor set 
to 1. 

RLU/s = cps ßßßßRLU factor 

The factory-set factor (=1) should be changed only when 
comparing results measured with different luminometers. The 
entered factor multiplies all measured results; it is changed on the 
main menu under SYSTEM. 

Overload 

If one or several measured values in the measurement interval 
exceed the measuring range of the luminometer, OVERLOAD 
appears on the display. To obtain a meaningful result, the sample 
has to be diluted and measured again. 

DONE                 OVERLOAD RLU/s 

REMOVE SAMPLE    MAIN 

Definition of measurement and delay time 

 
 

      delay time              measurement time 
 

Close sample drawer Time axis (seconds) 
 

All delay times start with the closing of the sample drawer. The 
minimum delay time is 1 s. 

Figure 3: 
Illustration of 
delay and 
measurement 
times 

!  
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Discarding and repeating a measurement  

Opening the sample drawer will terminate a measurement. 

In the raw data mode the display shows: 

MEAS. ABORTED! 

PRESS ENTER! 

Close the sample drawer and push <ENTER> to start the next 
measurement. 

 

In case of a cut-off measurement (only possible if the interface 
has been set to PRINTER), the following display appears: 
 

MEAS. ABORTED! 

REPEAT  DISCARD 

REPEAT Repeat measurement of replicate sample. 

DISCARD Measure next sample. 

The measured values are calculated depending on this selection. 

 

Data output on display 

Only raw data in RLU/s are displayed. 
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3.2 Raw Data Measurement 

In the raw data mode, samples are measured and numbered 
consecutively. 

Creating a protocol1)  

FB12 LUMINOMETER  

MEASURE MEAS.SET NEXT 
                                                                                Ð 

DELAY TIME:  2.0 s 

SCROLL   CURSOR NEXT 

  
MEASURING TIME:  10.0 s 

SCROLL   CURSOR MAIN 

� Define delay time and measurement time. 

� Press MAIN to return to the main menu. 
 

Raw Data Measurement 

� The display shows the main menu: 

FB12 LUMINOMETER  

MEASURE  MEAS.SET NEXT 
 Ð 

READY  30 RLU/s 

   D= 2.0s T= 10.0s MAIN 

� Insert sample tube and close sample drawer. The 
measurement starts. 

MEASURE  4500  RLU/s 

   D= 2.0s    T= 10.0s MAIN 

� At the end of the measurement time the following display 
appears: 

DONE  4500 RLU/s 

REMOVE SAMPLE  MAIN 

1) If the interface has been set to PRINTER, you can here choose between raw 
data and cut-off (see chapter 11). 
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3.3 Check Mode 
 

The check function enables the user to check the photomultiplier 
if no measurement is running. The measured RLU values are 
displayed continuously regardless of whether the sample drawer 
is open or closed. Push MAIN to terminate the measurement. 

 
        

PC-OPER SYSTEM MAIN 

� Push the SYSTEM button to open the PARAMETER menu. 

SYSTEM 

CONFIG   CHECK         NEXT 

� Push the CHECK button. The selected measurement time is 
used as integration time. 

MEAS. TIME   10.0s 

SCROLL        CURSOR      NEXT 

� Change the measurement time with SCROLL and confirm 
with <ENTER>. Push NEXT to start the measurement. 

MEASURE  22 RLU/s 

T = 10.0s  MAIN 

� Push MAIN to return to the main menu. 
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4. Working with the FB12 PC Software 

4.1 PC Software Installation 

� Close all Windows applications. 

� Insert software CD in the CD drive. CD navigator is supposed 
to automatically start your internet browser. 

� Select “Software” in the navigator bar, then “FB12/Sirius 
Software Installation” on the respective site. 

� Double-click the Setup.exe file displayed in your Windows 
Explorer to start the setup program.  

� Alternatively, if the CD navigator does not automatically pop 
up, chose the [Start] menu in Windows. The [Run] dialog box 
appears. 

� In the [Open] text box, type x:\FB12\Software\Setup.exe (x 
stands for your CD drive). This will start the setup program 
too. 

� Click <Next>: [Select Program Manager Group]. 

� Click <Next> (display of [Start Installation]). 

� Click <Next> to start the installation.  

� If the prompt [Place installation disk2] is displayed, insert the 
installation disk 2 with the file FB12Setup.WO2 in drive A:/.  

� Upon completion of the installation process, click <Finish>. 

� The software includes a 30 days trial option for non-purchased 
software components. 

Important information for Windows NT/2000 users 

Please make sure to install and run the software in the 
administrator mode. If this is not possible you should obtain the 
required user rights from the administrator in order to be able to 
work with the software. 

!  
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Installation of additional protocol types 

Proceed as described above. Select the protocol types you want 
in the [Software Components] dialog box. Then complete the 
installation. 

4.2 First Program Start 

� Double-click on the FB12 software ICON.  

� Click on the <Options> button.  

� Select the serial port used (COM1 or COM2) in the [Serial 
Port] box. Set the baud rate to [9600]. 

� In the [Default Data storage directory] box, enter the directory 
where you wish to save the measurement data. 

� If you want to hear a signal at the end of a measurement, 
select the item [Beep when measurement is completed]. 

� Click <OK> to save the entries. The program changes to the 
Protocol Manager. 

Software Registration 

Enter the registration passwords (one for each protocol type) in 
the [Registration Form] dialog box. 
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4.3 Basic Software Structure 

Protocol Manager 

         
 

 

 
 

       

Figure 4: 
Structure of  
FB12 PC program 

Create a protocol
Measurement menu

Save 

Graphics display 

 

EXCEL 
transfer 
options

Opening 
a data 

file 

EXCEL
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4.3.1 Protocol Manager 

[Protocol types] 
Shows the protocol types which can be used as templates for 
creating protocols. 
 
[Runable protocols] 
Shows a list of created protocols. Protocols are edited using the 
buttons in this box: 
 

<Run>  
Shows the measurement menu and you can start a 
measurement with the selected protocol.  

 
<Edit>  
Edit the parameters in the selected protocol. 

 
<Delete>  
Delete the selected protocol. 

 
Quick Measurement  
is not a protocol type, but a measurement protocol; parameters 
may be changed, but may not be stored in separate protocols. 
 
<Retrieve>  
Shows the stored measurement data; double-click to open the 
desired data file (*.MDS).  
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4.3.2 Measurement Menu 

Select the desired protocol and click <Run>. The measurement 
menu is displayed. 

 
Before starting a run  
On the luminometer: Select NEXT and then PC-OPER (see 
chapter 4.4).  
 
Measurement start  
By opening / closing the sample drawer or pressing the green 
button or the spacebar. 
 
Meas. completed  
As soon as the measurement time is over. 
 
Measurement stop  
By opening the sample drawer or pressing the red button. 
 
Single values  
Measured results are transferred from the luminometer to the PC 
every 0.2 seconds. To view single values, place the cursor over a 
measured result. 
 
Result fields  
To change the size of a result field, move cursor to the right-hand 
margin of the header. As soon as the cursor shape changes to a 
double-arrow, click the left mouse button and drag the cursor, 
with the mouse button held down, left or right.  
 
EXCEL Transfer  
Click the button depicted to the left to manually import data into a 
new or predefined Excel worksheet. The transfer may also be 
automated in the protocol. 
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4.3.3 Working with the Software 

Tool buttons on the measurement menu simplify program 
handling. Apart from a few exceptions you need not select any 
pull-down menus. 

Tool buttons and their meaning: 

  Button     Meaning Pull-down menu -> Option 

 
Save measurement 
data 

[File] -> [Save (as)] 

 
Import measurement 
data into Excel 

[Edit] ->[Send to Excel] 

 
Print [File] -> [Print] 

 
Start measurement  [Measure] -> [Start Measurement] 

 
Stop measurement [Measure] -> [Stop Measurement] 

 
Delete last 
measurement  

[Measure] -> [Delete Last 
Measurement] 

 
Display results in 
spreadsheet  

[Measure] -> [Kinetics]  

 
Display results in a 
graph 

[Measure] -> [Kinetics] 

 
Tile window 
horizontally 

[Window] -> [Tile Horizontal] 

 
Tile window vertically [Window] -> [Tile Vertical] 

 
Create new data file 
in measurement 
menu  

 

 
Copy selected data to 
clipboard  
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4.4 FB12 Luminometer Setup 

� Connect the FB12 luminometer with the cable supplied to a 
serial COM port on your PC. 

� Select NEXT and PC-OPER on the main menu to set the 
FB12 luminometer to PC operation. 

FB12 Luminometer 

Measure MEAS.SET NEXT 

 
FB12 Luminometer 

PC Oper SYSTEM MAIN 

 
PC-OPERATION  30 RLU/s 

DOOR OPEN  END 

 

� The measuring instrument is now in the PC operation mode. 
The measured values are displayed continuously in the top 
row. The bottom row shows the status of the sample drawer. 
Push END to return to the standalone mode. 

Note! 

The function PC operation is not available if the serial interface 
has been set to PRINTER. To configure the interface for PC 
operation, set the RS232 interface configuration on the SYSTEM 
menu to PC communication. 

 
  

         SYSTEM       NEXT 
 

 

 SYSTEM 

 CONFIG      CHECK     NEXT 
 
 

 RS232 FUER             PC/PRINTER 

 SCROLL         MAIN   NEXT 
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� Push SCROLL and change the instrument from PRINTER 
configuration to PC configuration. 

� Push <ENTER> to confirm your entry. Push MAIN to return to 
the main menu. 

� On the main menu, select NEXT and then PC-OPER which is 
now available. 
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4.5 Comparison of Software Protocols 

To help you get a quick overview of the different protocol types, we 
have summarized their functions in the table below: 

 Quick 
Measur. 

Single 
Assay 

Single 
Kinetics 

Multiple 
Kinetics 

Dual 
Assay 

Cut-Off- 
Assay 

Function  Measurement of 
several samples 
with replicates 

Continuous 
measurement of 
one sample 

Several samples, 
discontinuous 
measurement 

Measurement of 
sample series A 
and B 

Classification of 
samples 

1st sample = BG no yes no 

BG may be 
defined 

no 

BG may be 
defined 

yes Yes 

Replicates no flexible yes yes same number 
for A and B 

yes: for 
samples,  
neg. and pos. 
controls 

Number of 
samples 

any flexible 1 sample 
measured with 
any data points 

any, with any data 
points 

same number 
for A and B 

yes: for 
samples,  
neg. and pos. 
controls 

Calculations none >1 replicate: 

average value 

%stdv/av  

>1 replicate: 

average value 

%stdv/av 

repl. 1, repl. 2 
log/normal 
scaling, 

smoothing, 

peak half-life time 
during increase 
and decay 

>1 replicate: 

average value 

%stdv/av 

repl. 1, repl. 2 
log/normal 
scaling, 

smoothing, 

peak half-life time 
during increase 
and decay 

>1 replicate: 

average value 

%stdv/av 

 

>1 replicate: 

average value 

%stdv/av 

 

Kinetics graph none always for last 
sample 

complete graph of 
all replicates 

complete graph of 
all replicates 

always for last 
sample 

always for last 
sample 

Miscellaneous Meas. 
sequence

predefined 
sample names 

 measurement 
start only at 
closing of sample 
drawer 

predefined 
sample names 

different 
calculation 
formulas for A 
and B 

predefined 
sample names 

different cut-off 
calculations and 
classifications 

BG = Background 
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5. Quick Measurement 

This protocol type measures the raw data of consecutively 
numbered samples. 

5.1 Protocol 

� In the Protocol Manager, select the [Quick Measurement] 
protocol and click <Edit>. The [Quick Measurement 
Parameters] dialog box appears. 

� Set Delay time for the measurement and Measurement time 
by clicking on the respective arrow buttons.  

� Click <Save> to save the measurement parameters. The 
program returns to the Protocol Manager. 

5.2 Measurements 

� In the Protocol Manager, select the [Quick Measurement] 
protocol and click <Run>. The measurement menu appears 
showing the parameters Measurement time and Delay time 
defined for the measurement. 

� Open sample drawer and insert sample tube. 

� Close sample drawer. The measurement process starts as 
soon as the preset delay time is over.  

� The result is displayed at the end of the measurement. 

� Proceed in the same manner to measure the next sample. 
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6. Single Assay 

This protocol type allows you to run background measurements 
and to measure replicates of samples. 

6.1 Protocol 

Select Single Assay and push <Create>. 
 

 
 

[Delay time]  
Delay before measurement; can be set only if a measurement is 
started by closing the sample drawer. 

[Measurement time]  
Measurement time for each sample measurement.  

[Start Meas. by]  
Select how to start the measurement on the measurement menu: 

[Start button]   
By clicking the Start button or pressing the spacebar. No 
delay time can be defined here! 

Figure 6-1:
Dialog box 

[Single Assay 
Parameters]

Page 1
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[Door close]   
By closing the sample drawer of the luminometer.  

[Number of replicates]  

[Number of samples]  

[First sample is background] Measurements of the first sample 
replicate are considered background measurements. 

 
<Advanced Options>  
Opens page 2 of the Single Assay Parameters dialog box. 

 

 
 

 
[Grid Options]  
You may select a flexible table set-up, so that the number of 
replicates and/or samples may be changed during measurement 
at the push of a button. 

[Measurement orders]  
Order of measurement 

[Across] 
Measurements are carried out by rows: first, all replicates of 
the first sample, then all those of the second sample, etc. 

Sample Rep1 Rep2 
1   
2   
3   

 

Figure 6-2:
Dialog box [Single 

Assay 
Parameters]

Page 2
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[Down] 
Measurements are done by columns, e.g. first the first 
replicate of all samples, then the second replicate of all 
samples, etc. 

6.2 Measurements 

Preparation At luminometer: Select NEXT and then PC-OPER. 
In the PC software : Select a protocol (type Single Assay), click 
<Run> and the program will go to the measurement menu.  

Parameter Display of the run parameters. If you have defined the number of 
replicates as variable, you may change this by clicking on the 
respective button. A background value can also be set manually if 
no background measurement is carried out. The value entered 
here is subtracted from the raw data of each sample. 

Measurement start By opening / closing the sample drawer or by clicking on the Start 
button.  

Results The measurement values will be displayed in a table depending 
on the definition in the protocol with the following columns (one 
row for each sample): 

 [Sample] Sample name.  

 [Rep...] One column has been reserved for each 
replicate. If the number of replicates was defined 
as variable in the protocol, you may increase the 
number of columns by clicking the appropriate 
button (+). 

 [Average] This column contains the average values, 
calculated from the replicate results of that row.  

 [%SD/Avg] Standard deviation in percent, divided by average 
value. 

 [Net] Average value minus background value. 

 [%SD/Net] Standard deviation in percent, divided by net 
average value. 

Graph The measurement data trend of each single measurement with 
data points can be displayed in a graph, either online or at the 
end of the measurement, by clicking the graph button.  

Sample Rep1 Rep2 
1   
2   
3   
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7. Dual Assay 

In the measurement mode Dual Assay two sample sequences A 
and B are measured. Subsequently, a mathematical correlation is 
established between both measurement sequences.  

Typical application: Dual reporter gene assays. 

 

7.1 Protocol 

Select Dual Assay and press <Create>. 

 

 
 

[Series A measurement and delay time] 

[Delay time]  
Delay for sequence A prior to each measurement; can be set only 
if a measurement is started by closing the sample drawer. 

[Measurement time] for each sample measurement of series A.  

[Series B measurement and delay time] 

Enter parameters for series B in the same manner as for series A. 

Figure 7-1: 
Dialog box 

[Dual Assay 
Parameters] 

 
Page 1 
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[Start Meas. by]  
Select how to start the measurement: 

[Start button]  
By clicking on the Start button or by pressing the spacebar. No 
delay time can be defined here! 

[Door close]  
By closing the sample drawer. 
 

[Number of replicates and samples] 

[Number of replicates]  

[Number of samples]  

[First sample is background]  
Measurements of the first sample replicate are considered 
background measurements. 
 

[Measurement options] 

[Transform]  
Select the calculation formula. 

[Measurement order] 
Selection of order: Either one sample of sequence B after each 
one of sequence A, or all samples of sequence A in a row and 
then all those of sequence B. 
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7.2 Measurements 

Preparation At luminometer: Select NEXT and then PC-OPER.  
In the PC software: Select a protocol (type Dual Assay), click 
<Run> and the program will go to the measurement menu.  

Parameter Display of measurement parameters series A and series B. The 
measured background values are displayed in the [Background 
A] and [Background B] text boxes, if the first sample of each 
sequence was defined as background in the protocol. A 
background value can be entered manually. The value displayed 
here will be subtracted from the raw data of each sample. 

Measurement start By opening / closing the sample drawer or by clicking the Start 
button.  

Results Display of measured values: 

[Sample] Sample name.  

[Net A] Net rate of series A = average value of the 
replicates of the first sample of sequence A, 
minus background. 

 [Net B] Net rate of series B 

[A ...B] Calculation of the two net rates according to the 
formula defined in the protocol  

 [%SD/Avg] Standard deviation in percent/average value. 

[Rep ...A] Measurement value for replicates of series A.  

 [Average A] Average value from replicate results of series A of 
the respective row. 

[%SD/Avg] Standard deviation in percent/average value. 

[Net] Average value minus background (series A). 

[%SD/Net] Standard deviation in percent/average value. 

The following columns contain the measured values for series B. 
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8. Single Kinetics 

The measurement type Single Kinetics is used to measure the 
trend of the light emission over a specific period of time. 

8.1 Protocol 

Select Single Kinetics and push <Create>. 
 

 
 

 
[Time settings]  
The following 5 parameters of this group box are mutually 
conditional (with the exception of delay time): 

[Delay time]  
Delay before each measurement; can be set only if a 
measurement is started by closing the sample drawer. 

[Total duration]  
Total sample measurement time, including the following times: 

[Sampling time]  
Measurement time per data point.  

Figure 8-1:
Dialog box 

[Single Kinetics 
Parameters]

Page 1
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[No. of Data points]  
Number of data points multiplied by the interval time shows the 
total duration of the measurement. 

[Interval time]  
The interval time may be longer than the individual measurement 
time of the data point.  

[Start Meas. by]  
Select how measurement is to be started on the measurement 
menu. 

[Start button]  
By clicking the Start button or pressing the spacebar. No delay 
time can be defined here! 

[Door close]  
By closing the sample drawer. Measurements with injectors can 
only be started in this manner. 

[Number of replicates]  
 
<Advanced Options> 
Click this button to open page 2 of the Single Kinetics 
Parameters dialog box. 

[Use luminometer as time basis]  
Select the luminometer as time basis. 
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8.2 Measurements 

Preparation At luminometer: Select NEXT and then PC-OPER. 
In the PC software: Select a protocol (type Single Kinetics), click 
<Run> and the program will go to the measurement menu.  

Parameter Display of measurement parameters. You may type a background 
value into the [Background RLU/s] box. The value entered here 
is subtracted from the raw data of each sample. 

Measurement start By opening/closing the sample drawer or by clicking the Start button.  

Results The measurement values will be displayed in a table depending 
on the definition in the protocol with the following columns (one 
row for each sample): 

[Time] Length of time the light emission is measured.  

[Rep...] Measurement values for individual replicates. 

[Average] Average value of replicates.  

[%stdv/Av] Standard deviation in percent, divided by average 
value. 

[Net] Net value (average value minus BG value) 

[%SD/Net] Standard deviation in percent, divided by net 
average value.  

Graph The measurement data trend of each single measurement can be 
displayed in a graph, either online or at the end of the 
measurement, by clicking the graph button. Further options for 
processing the graph become visible when you enlarge the graph 
window. 

[Group] Select which replicate curve(s) is to be displayed.  

[Smoothing]  Smoothes all displayed curves. 

[Log scale]   Logarithmic scaling. 

[RLU-range]  Select if scaling is to be applied automatically or 
manually. 
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9. Multiple Kinetics 

In the Multiple Kinetics mode, the trend of several samples is 
measured in parallel over a longer period of time.  

 

9.1 Protocol 

Select Multiple Kinetics and push <Create>. 
 

 
 
[Time settings]  
The following 5 parameters of this group box are mutually 
conditional (with the exception of delay time): 
 
[Delay time]  
Delay before every measurement. 
 
[Total duration]  
Total sample measurement time, including the following times: 
 
[Sampling time]  
Measurement time per data point.  

Figure 9-1:
Dialog box 

[Multiple Kinetics 
Parameters]

Page 1
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[No. of Data points]  
Number of data points multiplied by the interval time shows the 
total duration of the measurement. 
 
[Interval time]  
The interval time may be longer than the respective measurement 
time of the data point. 
 
[Number of replicates / samples]  
The number of replicates or samples. 
 

Please note:  A measurement can only be started by closing the sample 
drawer. 

 

9.2 Measurements 

Preparation At luminometer: Select NEXT and then PC-OPER.  
In the PC software: Select a protocol (type Multiple Kinetics), 
click <Run> and the program will go to the measurement menu.  

Parameter Display of measurement parameters. You may type a background 
value into the [Background RLU/s] box. The value entered here 
is subtracted from the raw data of each sample. 

Measurement start By opening/closing the sample drawer or by clicking the Start button.  

Results Measured values are displayed in a table: 

[Time] Length of time, over which the light emission is 
measured. The number of data points in [time] is 
calculated by dividing the total measurement 
duration by the interval time. 

[S1 Rep1] Measurement value of the first replicate of the first 
sample. 

[S1 Rep2] Measurement value of the second replicate of the first 
sample. 

[Average] Average value of  replicates of the first sample. 

[%SD/Avg] Standard deviation in percent, divided by average 
value. 

[Net] Net value (average value minus BG value). 
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[%SD/Net] Standard deviation in percent, divided by net 
average value. 

[S2 Rep1] Measurement value of the first replicate of the second 
sample. 

[S2 Rep2] Measurement value of the second replicate of the 
second sample. 

[Average] Average value of  replicates of the second sample. 

[%SD/avg] Standard deviation in percent, divided by average 
value. 

[Net] Net value (average value minus BG value). 

[%SD/Net] Standard deviation in percent, divided by net 
average value. 

[S...Rep...] Further samples with replicates. 

Graph The measurement data trend of each single measurement can be 
displayed in a graph, either online or at the end of the 
measurement, by clicking the graph button. Further options for 
processing the graph become visible when you enlarge the graph 
window. 
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10. Cut-off Assay 

A Cut-off protocol classifies samples into three categories. So-
called cut-off thresholds (high and low) are measured by defining 
fixed parameters and measuring negative and positive controls.  

10.1 Protocol 

Select Cut-off ASSAY and press <Create>. 
 

 
 

[Delay time]  
Delay time before measurement; can be set only if measurement 
is started by closing the sample drawer. 

 [Measur. time]  
Measurement time for each sample measurement.  

[Start Meas. by]  
Select how to start the measurement on the measurement menu: 

Figure 10-1: 
Dialog box 

[Cut-off 
Parameters] 

 
Page 1 
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[Start button]   
By clicking the Start button or pressing the spacebar. No 
delay time can be defined here! 

[Door close]   
By closing the sample drawer of the luminometer.  

 
[Analytes] Define the number of replicates and samples. 
 
[Negative/Positive controls]  
Define the number of replicates of negative and positive controls. 
 
[First sample is background]  
Measurements of the first sample replicates are treated as 
background measurements. 
  
[Cut-off calculations] 
Definition of low and high threshold by the following parameters: 

[Offset] Offset (RLU) value 
+ [Neg. Factor] any constant 
x [Neg. Net] net rate of negative control 
+ [Pos. Factor] any constant 
x [Pos. Net] net rate of positive control 

 

<Advanced Options> 
Click this button to open page 2 of the Cut-off Parameters dialog 
box. 
 
[Result text]  
Designation for Cut-off results. The following designations are 
defaulted: 

[Negative result text] NEG 

[Positive result text] POS 

[Equivocal result text] +/- 



 
 FB12 Luminometer 10. Cut-off Assay 
 

 

 35 

10.2 Measurements 

Preparation At luminometer: Select NEXT and then PC-OPER.  
In the PC software: Select a protocol (type Cut-off), click <Run> 
and the program will go to the measurement menu.  

Parameter Display of measurement parameters. You may type a background 
value into the [Background RLU/s] box. The value entered here 
is subtracted from the raw data of each sample. 

Measurement start By opening/closing the sample drawer or by clicking the Start button.  

Results Measured values are displayed in a table: 

[Sample] Sample name.  

[Rep...] A column is reserved for each replicate. 

[Result] Result column. POS, NEG or +/- as result. 

[Average] Average value from the replicates of one sample. 

[%SD/Avg] Standard deviation in percent/average value 

[Net] Average value minus background value. 

[%SD/Net] Standard deviation in percent/net average value. 
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11. External Printer with Additional Options 

The FB12 luminometer can be upgraded by an external serial 
printer to output the measured results directly to printer. To this 
end, the interface has to be set to PRINTER in the instrument 
software. In this mode, cut-off measurements can be carried out 
in addition to extended raw data measurements and their results 
can be output to printer. 

 

The serial port is designed for the serial printer Seiko Instruments 
TM DPU-414, which you can order directly from Berthold 
Detections Systems. 

 

11.1 Physical Installation of the Printer 

� The Seiko TM DPU-414 Thermal Printer is supplied with a 
power supply (7.5V) and an interface cable (9 pin data cable, 
male-female)  

� Plug the appropriate plug module into the power supply. The 
power pack adjusts to the supply voltage of 220V or 110V. 

� The power supply should be properly plugged into the wall 
outlet, while the pin plug is plugged into the connection at the 
back side of the printer. 

� The power supply of the printer and the luminometer can be 
discriminated by the standard device plug (5,5mm) and the 
CINCH plug (3.5mmm), respectively. 

� Connect the enclosed interface cable to the serial ports. The 
female end should be plugged in to the back of the FB12, 
while the male end should be plugged in to the pack of the 
printer. 
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11.2 Printer Setup 

From the main menu on the FB12, press the NEXT button and go 
into SYSTEM.  

 
 FB12 LUMINOMETER V2.2 

 MEASURE      MEAS.SET.      NEXT 

  Ð 
  

 PC-OPER      SYSTEM       NEXT 

Ð 
 SYSTEM 

 CONFIG        CHECK     NEXT 

   Ð 
 RS232 FOR             PC / PRINTER 

  SCROLL         MAIN     NEXT 

 
❏ Press SCROLL to adjust the instrument from PC configuration 

to the printer configuration. Confirm your entry with <ENTER>. 

❏ Push MAIN to return to the main menu. 

 

 

11.3 Cut-Off Protocol 

Provided the interface is set to PRINTER, you can choose either 
cut-off protocol or extended raw data protocol by pushing 
MEAS.SET. on the main menu (see chapter 11.5) and define the 
respective protocols: 

 
 FB12 LUMINOMETER V3.0 

 MEASURE      MEAS.SET.      NEXT 

 Ð 
 PROTOCOL       RD/ CUT-OFF 

 SCROLL       MAIN       NEXT 
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� Push SCROLL to select the cut-off protocol. 
 

OPERATOR   ...................... 

SCROLL  CURSOR  NEXT 

  Ð 
TESTNAME   ...................... 

SCROLL  CURSOR       NEXT 

 

Enter a user name and a test name and then define the cut-off 
factor, the number of negative standard replicates, the sample 
replicates, the delay time and the measuring time: 
 

CUT-OFF-FAKTOR:           X.XXX 

SCROLL  CURSOR NEXT 

        Ð 
NEG. STAND. REPL.:  2 

SCROLL  CURSOR  NEXT 

     Ð 
SAMPLE REPL.:  1 

SCROLL  CURSOR NEXT 

   Ð 
DELAY TIME:  2.0 s 

SCROLL  CURSOR NEXT 

   Ð 
MEASURING TIME:  10.0 s 

SCROLL  CURSOR NEXT 
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11.4 Cut-off Measurement 

The CUT-OFF protocol will allow replicates to be measured and 
classified as positive or negative samples. This is done by 
calculating a Cut-off threshold. Based on the average of the 
negative standard replicates and the Cut-off factor this threshold 
is calculated as follows:  

 

Ned-STD.-Replicates –Average x Cutoff-Factor = Cutoff-threshold 
 

The RLU value of the negative standard replicates are measured 
at the beginning of the measurement sequence. From there the 
Cutoff-threshold is calculated. 

If the interface has been set to PRINTER and you have selected 
the cut-off protocol (after you have pushed MEAS.SET.), you can 
run a cut-off measurement by selecting MEASURE on the main 
menu: 

� Select menu MEASURE. 

� The Cut-off measurement menu starts.  

� Place tubes for negative standard replicate 1 and close 
sample drawer to start the measurement sequence. 

� Open sample drawer at the end of the measurement and 
remove sample tube. 

� Proceed as instructed on the display: insert sample tube for 
2nd negative standard replicate and close sample drawer.  

� Average value and standard deviation are calculated and 
printed out after completion of all standard measurements. 
You are then prompted to insert the first sample replicate. 

� Close sample drawer. The measured values as well as the 
result of the sample classification are printed out at the end of 
the measurement. 

� Open sample drawer and replace sample tube. 

� Following this protocol you can measure as many samples as 
you choose. 
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Printout to external printer  
 
Example:  Date: XX.XX.XXXX    XX:XX 
  Name:  
  CUT OFF Assay: 

Neg. STD Repl = 3 Sample replicate = 1 
Delay-Time = 2.0s Meas.Time = 5.0s 
Cut-off factor = 2.000 

 
Neg. STD Repl. Result 
 1    415 RLU/s 

2    435 RLU/s 
3    410 RLU/s 

 
Neg. Standard Avg = 420 RLU/s 
%VC     = 2.6% 
Cut-Off-Value  =  840 RLU/s 

 

Then the samples to be classified may be measured. Based on 
the calculated Cut-Off value of e.g. 840 RLU/s, any measurement 
results below 840 RLU/s will be denoted as NEGATIVE, while any 
value above 840 RLU/s will be denoted POSITIVE. 

 
 

11.5 Extended Raw Data Protocol  

With the interface set to PRINTER, select the raw data protocol 
on the main menu as follows: 

 
 FB12 LUMINOMETER V3.0 

 MEASURE      MEAS.SET.      NEXT 

  Ð 
 PROTOKOLL      RD/ CUT-OFF 

 SCROLL       MAIN       NEXT 

 

Push SCROLL to select the raw data protocol. In this case, the 
raw data protocol is extended: you may enter a user name and a 
test name in addition. 
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11.6 Raw Data Measurement 

A raw data measurement is started just like a cut-off 
measurement by selecting the MEASURE menu. 

The current measured value is printed out without any further 
modification or calculation. In addition, the measurement 
parameters you have defined, the date as well as the entered 
user and test name will be documented. 
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12. Maintenance 

The FB12 luminometer is practically maintenance-free. It only has 
to be protected from dirt and may have to be cleaned. 

The surface of the instrument is protected by a robust and 
washable finish. Should it become dirty or dusty, we recommend 
wiping it with a damp cloth. If necessary a mild detergent (not an 
abrasive!) can be used. 

The sample drawer and especially the measurement window also 
have to be kept clean and should be wiped off with a damp cloth 
if dirty. 

Please keep in mind that the screw on top of the instrument must 
always be firmly closed. The PMT may get damaged by incidence 
of light.  

 

No fluid should ever enter the instrument! If this should 
happen, disconnect the instrument immediately and notify a 
service representative! 

 

!
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13. Technical Data 

 

Sample format • Sample tubes with up to 12 mm diameter (12 mm = standard) 
and up to 75 mm length, with or without cap 

• Culture dishes with max. 35 mm diameter 
• Scintillation vials with up to 20 ml content 
• Reaction containers 

Detector Single photon counter (370 - 630 nm) 

Sensitivity  Better than 1,000 luciferase molecules in one reporter gene 
assay, ATP detection is only dependent on the reagents used  

Dynamic range  6 decades 

Hardware Micro-controller controlling all instrument functions 

Microprocessor 
software 

• 3 softkeys and 1 <ENTER> button 
• Delay and measurement time definition in increments of    

0.1 s 
• 2 measurement modes: Raw Data measurement,  Cut-Off 

(option) 
• Standard and Check mode 
• Data transfer via RS 232 interface  

PC software MS Windows application for control, measurement and evaluation 

Measurement time 0 - 99.9 s 

Interfaces  Serial RS 232 interface for PC connection 

Printer External printer (option) 

Dimensions  W 220 mm, D 170 mm, H 220 mm 

Weight approx. 2.5 kg 

Power supply  DC 12 V / 2.5A (peek); 1 A average 

Temperature range Storage 0° - 40° C 
Operation 10° – 35°C 

Humidity 10% - 80% 
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Accessories 

Order number Description 

18100010 Reflector type RFB201.3 

18120010 Power supply unit (12V, min. 0.8 A, input voltage 100-240V ) 

18200250 Serial data cable 

13200500 5 ml tubes, 12x75 mm, 500 each 

15300100 External thermo printer Seiko DPU 414 with data cable, power 
supply (12V, min. 0,8 A, input voltage 100-240V) 

Platform/ Required 
Hardware 

Windows® compatible PC, Pentium like processor, one available 
serial port. 

Operating System  Windows® 98, ME, XP, NT 4.0, 2000, XP professional 

Additional Software Microsoft® EXCEL 97, 2000, XP (optional) 
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14.  Preparing FB12 for Transport 
 

If it should become necessary that FB12 has to be serviced please 
observe the following instructions for shipping it to your local 
distributor or Berthold Detection Systems. 

 
1. Turn luminometer off and disconnect power supply. 

 
 

2. Remove the reflector. 
 
 

3. Pack the luminometer into the plastic bag and put it into the white 
original packing together with the brown placeholder cardboard 
box, the accessories box and the flat place holder. Put this in the 
brown dispatch cardboard box. If you return the manual also, 
please put it on top of the white cardboard box. 
 

Flat place holder 

Accessories box 
 Original packaging 
FB12 Luminometer: 

 

4. Complete the packaging by filling out the box with paper and seal 
the dispatch cardboard box. Please contact service@Berthold-
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ds.com or your local dealer if you need any packaging material. 
Improper packing may cause damage during transportation. 
 

 
5. Before return please contact your local distributor or Berthold 

Detection systems for shipping instructions. 
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software structure...........................13, 16 
stand-alone mode...................................7 
system description..................................3 
technical data .......................................43 
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16. Decontamination Form 
Any laboratory instrument used for clinical or research analysis maybe considered a 
biohazard and requires decontamination prior to handling. Universal precautions are 
suggested wherever applicable. 

 
Before shipping any instrument back to Berthold Detection Systems the 
luminometers have to be cleaned in the following way:  
 
1. Wash the housing with a moist cloth, if necessary use a mild detergent or 

disinfectant. Do not use any scouring agents! 
2. Open the access door, remove and clean the reflector, then clean the 

measurement chamber with the measurement window carefully. Use e.g. 
cotton buds for hard to access locations. 

 
Berthold Detection Systems only accepts instruments for repair together with a filled 
out decontamination form. Please copy this page and fax it to us before you send off 
the package. Thank you. 
 
Instrument Type: 
 
Serial Number: 

 
 I confirm that the specified instrument was decontaminated  

according to the above described decontamination procedure 
 

  I confirm that the above specified instrument had no contact to  
any hazardous material. 

 
Company  

Contact Person  

Position  

Telephone  

 
 
 

Date:__________________ Signature: ________________________________ 
 
 

Please copy and fax to: 
Berthold Detection Systems, Bleichstr. 56-68, 75173 Pforzheim,  
Tel.:+49-(0)7231-9206-0, Fax -50 
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